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Warmer temperatures and irregular rainfall 

are affecting coffee production worldwide. 

As this begins to impact production, there 

will be opportunities for new producing 

countries to fill gaps in global supply 

and support specialty coffee buyers’ 

diversification efforts. Sri Lanka, as an 

emerging producer, has the potential to 

fill this niche, however it must expand 

production in a climate-resilient manner to 

sustain its position as a sourcing origin.

Australia's Market Development Facility (MDF) 

recently conducted a study to understand the impact 

of climate change on the suitability for Arabica 

cultivation in Sri Lanka. This brief sets out the market 

landscape, the study’s projected impact from climate 

change, and suggestions on how coffee businesses, 

farmers and other stakeholders can invest in adapting 

to future climate changes and building a resilient and 

competitive coffee industry in Sri Lanka.
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Market context

Variety

Arabica is the most popular variety of coffee due to its flavour profile, despite being  
more vulnerable to climate change than other varieties. In comparison, the Robusta variety 

is better suited for cultivation at higher temperatures and lower elevations and has higher 

yield; however, the market price is lower. Arabica grows well in the central highlands at 

average temperatures of 18–24°C, heights of 1,000-2,200m and annual rainfall of  

1,500–2,750mm.

Demand

In the past 30 years, global coffee consumption has almost doubled, and around 3 billion 

cups of coffee are consumed daily.  Total world coffee production increased by 0.1 per cent 

to 168.2 million bags in 2023, of which Arabica coffee saw a 1.8 per cent increase to  

94 million bags. Total coffee output is expected to increase by 5.8 per cent to 178 million 
bags in 2024, of which Arabica coffee is expected to increase by 8.8 per cent.1

Climate change

Climate change, particularly the rise in global temperatures, is a threat to Arabica coffee 

cultivation. Brazil and Ethiopia, two major coffee producers, could lose 7 per cent and 

40 per cent, respectively, of their coffee-growing land in the next decade if global 
temperatures rise above 1.2°C. The Intergovernmental Panel on Climate Change2 projects 

a 1.5 °C temperature increase by the first half of the 2030s.

1 International Coffee Organization.

2 The Intergovernmental Panel on Climate Change (IPCC), created in 1988, is the United Nations body for assessing the science related 
to climate change. It provides regular assessments of the scientific basis of climate change, its impacts and future risks, and options for 
adaptation and mitigation.
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Sri Lanka’s advantage 

Sri Lanka is an emerging coffee producing country with low coffee volumes compared to 

other major producing nations such as Brazil and Uganda, as well as regional producers 

such as Vietnam and India. This positions Sri Lanka to compete in niche segments such 

as Specialty Coffee where premium prices are paid for higher quality coffee and market 

demand isn’t driven primarily by volume. 

There is an opportunity for Sri Lanka to expand production in a climate-resilient manner, 
while avoiding the costs of transitioning plantations and infrastructure to higher altitudes or 

having to switch from Arabica to Robusta and other varieties.

Market requirements

European and North American markets increasingly prefer sustainably grown coffee. The 

new EU Deforestation Regulation (EUDR) will require proof (‘traceability’) that coffee was 

not grown in deforested areas. Countries with a high risk of deforestation, such as Brazil, 

Ethiopia and Indonesia, will be subject to greater scrutiny. For countries like Sri Lanka, 

implementing traceability systems and sustainable production practices could help to 

maintain access to high value markets and premium prices.



5

In 2024, MDF commissioned a climate scientist to assess the effects of climate change on Sri Lanka’s 

coffee industry. The study projected changes in temperature, rainfall, cyclones, and pest and disease 

outbreaks under low- and high-emission scenarios for 2030, 2050 and 2070, compared to the baseline 

year, 2000. The study also made recommendations to adapt to a changing climate.

From a nationwide baseline of 26.7°C, air temperature is projected to increase:

Higher air temperature will affect coffee farming in two ways: land at lower altitudes will become 

increasingly unsuitable for growing Arabica, and the frequency and severity of diseases and pests such 

as coffee leaf rust and coffee berry borer will increase.

Low-emissions future: High-emissions future:

+0.6°C +0.8°C+0.9°C +1.6°C
by 2030 by 2030by 2050 by 2050

Low-emissions and 
high-emissions 
future scenarios

A low-emissions future is the best-case scenario, 

where the world reduces greenhouse gas emissions, 

and the temperature increases by approximately 
1.1°C by 2050. A high-emissions future is the 

worst-case scenario, where the temperature increases 

by 1.8°C by 2050. Projections are simulations of 

Earth’s future climate based on these 'scenarios'.

Projected impact of 
climate change on  
Sri Lanka’s coffee

Hotter air temperature

CHANGE
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Impact 1: Less area to farm Arabica coffee (see Figure 1)

Five key districts were identified for this study due to their potential for future coffee 
production. Regardless of future emission scenario and time horizon, most districts 

experience a reduction in land area where annual average temperatures are optimal for coffee 
cultivation (18-24°C), except for Nuwara Eliya.

Figure 1. Percentage (%) of land area where annual average temperatures are optimal for 
coffee cultivation (18-24°C). All areas indicate a decline, except where denoted 
in green.

Impact 2: Increased prevalence of diseases and pests (see Figure 2)

Global research shows that an increase in temperature leads to a higher frequency of diseases 

such as coffee leaf rust (CLR) and pests like the coffee berry borer (CBB), which affect yields 

and quality. The five primary districts cultivating Arabica coffee are facing an increased 
threat of CLR due to January temperatures consistently exceeding 15°C. CLR is likely already 
widespread in Kegalle and Matale, where approximately 98 per cent of the land area has 
been experiencing these temperatures since the 1970-2000 baseline period. Projected 
temperature increases imply that this trend is expected to persist. Currently, Nuwara Eliya 
presents a lower CLR risk due to its cooler climate. However, as a rise in temperatures is 

anticipated, this risk is projected to escalate, as warmer conditions are more conducive to 

CLR.

Climate change, particularly temperature increases, can also exacerbate the incidence of CBB 
(Groenen, 2018). A 1°C increase in regions with average daily temperatures below 26.7°C 

would amplify the rate of CBB increase by around 8.5 per cent (Jaramillo et al., 2009). This 

could significantly influence pest dynamics, leading to increased pest pressure in regions 
with higher seasonal temperatures. Furthermore, rising temperatures could extend the CBB's 
geographic and altitudinal range, including regions with high-quality Arabica coffee, making 

it challenging to cultivate coffee in these areas (Jaramillo et al., 2011).
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Impact 3: Lower coffee production

Short-term weather irregularities, like more rain in the dry season and less rain in the wet 

season, can damage coffee flowers and affect yields. These rainfall changes can also cause 
erosion, affecting soil fertility and reducing future harvests. 

Impact 4: Lower coffee quality and post-harvest management

Unpredictable and extreme rainfall patterns can reduce coffee quality by increasing humidity 
and making it challenging to harvest, dry and store beans. Extreme rainfall can also damage 
roads, causing post-harvest losses when transporting coffee cherries and parchments to 

processors.

There is significant uncertainty in climate models around average annual rainfall change in Sri Lanka 
due to the many drivers of rainfall variability, as such there is low confidence in these projections for 
Sri Lanka.  By 2070, annual rainfall could increase by nine to 13 per cent under low- and high-emission 

scenarios. 

While average rainfall change is uncertain, there are more confident projections about an increase in 
the frequency and intensity of drought or heavy rain, due to increases in temperature. Irregular and 

extreme rainfall patterns could affect coffee farming in two ways: damaging flower growth and making 
harvesting, processing and transporting difficult, all of which hurt yields and quality.

Irregular and extreme rainfall patterns

CHANGE

Figure 2. Percentage (%) of land area where average minimum temperatures in January 
are at lower risk of CLR (where average minimum January temperatures <=15°C) 
defined as ‘optimal’.
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To maintain and take advantage of its competitive position in the specialty coffee market, Sri Lanka’s 

specialty coffee sector will need to invest in becoming more resilient to the impacts of climate change. 

The MDF study sets out recommendations that can be explored further by government, development 
partners, businesses and industry associations. These recommendations can be considered by the 

Government of Sri Lanka in its future coffee policy.  

MDF supports business partners to invest in these adaptation strategies and has been co-investing 

with partners in improving coffee drying infrastructure to reduce risks from changing rainfall patterns. 

Other proposed options to build resilience include:

Recommendations for 
adapting to climate change

Strengthen research and development capacity

Diversification in coffee varieties
Explore and cultivate coffee varieties that are more resilient to climate change, such as 
those with greater temperature, drought and disease resistance. 

Innovative agricultural practices

Invest in research to explore innovative agricultural techniques to ensure that present 
coffee producing regions can continue to grow coffee well into the future. 

Collaboration and networking

Foster cooperation and information exchange among coffee farmers, companies  and 
the government to share knowledge and best practices in climate adaptation. 

1

2

3
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Integrate climate-resilient agriculture practices into Arabica 
production

Water management

Invest in water management systems including improved catchment management and 

irrigation to counteract water scarcity during prolonged dry seasons. 

Soil conservation

Implement soil conservation techniques to maintain soil health and prevent erosion, 

ensuring coffee plant roots are less vulnerable to temperature and moisture 

fluctuations. 

Pest and disease control

Develop integrated pest and disease management strategies to address the changing 

patterns of coffee pests and diseases brought on by climate change (e.g. CLR, CBB and 

other diseases).  

Education and training

Provide farmers with training and resources to help them understand how the climate 

is expected to change, how they can access support and assistance, and ways in which 
they can implement some of the recommendations outlined in this report. 

Expand coffee production in a climate-resilient way

Explore new coffee-growing areas

As climate change continues to impact Sri Lanka, previously unsuitable areas may 

become more conducive to coffee cultivation. Existing and competing land-use 
priorities will need to be managed. 

4

5

6

7

8

Helanta Coffee conducting farmer trainings
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If you are a coffee business looking to invest in production, quality and/or climate resilience, 

get in touch with us: vishan.rajakaruna-mdf@thepalladiumgroup.com

Improve the coffee enabling environment

Access to finance
Facilitate access to financial resources to assist farmers with adaptation, including credit 
to fund adaptation activities and insurance as a method to transfer risk. 

Climate early warning and monitoring

Utilise climate and weather forecast information to provide seasonal outlooks to 

inform planning and decision-making and enhance climate monitoring capabilities and 

networks, such as weather monitoring stations to inform planning in the short and long 

term. 

9

10

The MDF Sri Lanka and Helanta Coffee teams assess coffee sapling quality
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Arabica

Arabica (Coffea arabica) is a species of coffee tree. Arabica coffee is considered of high quality and is 

prized for its smoother, sweeter flavour profile compared to Robusta coffee.

Robusta

Robusta (Coffea canephora) is a species of coffee tree. Robusta coffee is known for its distinct flavour 
profile, higher caffeine content and resilience to pests and diseases compared to Arabica coffee. 

Specialty coffee

Specialty coffee is coffee that scores above 80 points on a 100-point scale on various attributes, such as 

fragrance, aroma, flavour, aftertaste, acidity, body, balance, sweetness, clean up, and flavour uniformity.

Market Development Facility

The Market Development Facility (MDF) is a multi-country initiative which promotes sustainable 

economic development, through higher incomes for women and men, in our partner countries across the 

Indo-Pacific. 

We support partners from business and government to identify and grow commercial opportunities that 

are profitable, scalable and deliver social and environmental value. 

MDF is funded by the Australian Government through the Department of Foreign Affairs and Trade 

(DFAT) and is implemented by Palladium in partnership with Swisscontact.

In Sri Lanka, MDF operates in the tourism and agriculture sectors.
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1. Executive Summary 

Climate change is expected to impact the coffee industry across Sri Lanka. Changes in air temperature 

and rainfall (annual totals and extreme events) are likely to influence the conditions best suited for 

Arabica cultivation, potentially impacting Arabica quality and yield potential. This report evaluates the 

potential impacts of climate change on optimal growing conditions required for Arabica cultivation, 

demonstrating a potential loss of optimal Arabica growing land area for particular districts in Sri Lanka.  

The analysis of future climate scenarios in Sri Lanka reveals significant changes in temperature and 

rainfall patterns, which are expected to influence Arabica coffee cultivation across key growing 

districts. Under both low (SSP1-2.6) and high (SSP5-8.5) emissions scenarios, all districts, except 

Nuwara Eliya, will experience a decrease in land area where annual average temperatures remain 

within the optimal range (18-24°C) for Arabica cultivation. For instance, Kandy shows a substantial 

decrease from 50% in the baseline period to 29% and 11% in 2070 under low and high emissions 

scenarios, respectively. This warming trend suggests that traditional Arabica growing areas will face 

challenges in maintaining current production levels without adaptive strategies. 

In terms of rainfall, the projections indicate variability with both potential increases and decreases in 

mean annual rainfall, which could impact Arabica production. Specifically, while areas like Badulla and 

Matale are projected to maintain or slightly increase the percentage of land within the optimal rainfall 

range (1500-2750 mm annually), districts like Kandy and Kegalle are expected to see a decrease in 

land suitability due to changes in rainfall patterns. However, there is low confidence and significant 

uncertainties in future rainfall variability. Also, interannual phenomena like the El Niño-Southern 

Oscillation (ENSO) and the Indian Ocean Dipole (IOD) contribute to considerable year-to-year 

variability, leading to unpredictable coffee production and poses a challenge to maintaining 

consistent yield and quality. 

Furthermore, changes in minimum temperatures in January have implications for disease 

management, particularly concerning Coffee Leaf Rust (CLR). The analysis shows that the risk of this 

disease could increase as fewer districts will maintain the optimal lower temperature threshold needed 

to mitigate disease spread. This underscores the importance of developing robust disease 

management practices and considering varietal resistance as part of the strategy to adapt to changing 

climatic conditions. Findings highlight the need for stakeholders in the coffee sector to prioritise 

climate adaptation measures to ensure the sustainability of Arabica coffee production in Sri Lanka. 

To mitigate climate change impacts, growers and the industry as a whole can take steps to enhance 

the resilience of Sri Lanka’s Arabica sector. This may include the following: 

• Enhance water management and explore new cultivation areas: Investment in irrigation 

systems and other water management techniques can combat potential water scarcity, and 

exploring new areas for Arabica cultivation can compensate for climate-induced changes in 

traditional growing regions. 

• Integrated pest management and research: Developing comprehensive pest and disease 

control strategies, coupled with continued agricultural research, can address new challenges 

and sustain Arabica production. 
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• Financial support and risk management: Facilitating financial support and risk transfer 

methods, such as cooperative insurance, enables farmers to invest in adaptation strategies 

with more security. 

• Strengthen collaboration, monitoring, and education: Fostering a network among coffee 

stakeholders, coupled with enhanced climate monitoring and farmer training, can lead to 

informed decision-making and application of adaptive practices. 

The execution of these strategies requires contextual analysis tailored to the specific conditions of Sri 

Lanka’s Arabica coffee sector. Through anticipatory planning and the cultivation of adaptive 

capacities, the Arabica coffee industry in Sri Lanka can not only navigate the challenges posed by 

climate change but also discover avenues for sustainable growth and development. 
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2. Introduction 

2.1 Project description and report objectives 

In the mid-19th century, Sri Lanka emerged as a premier coffee producer, dominating the global 

coffee market before its transition to tea cultivation. Today, with a resurgence in coffee cultivation, 

particularly in the specialty coffee sector, Sri Lanka is poised to reclaim a significant position in the 

industry. Total world coffee production increased by 0.1 per cent to 168.2 million bags in 2023, out of 

which Arabica coffee saw a 1.8 per cent increase to 94 million bags. The total output for coffee is 

further expected to increase by 5.8 per cent to 178 million bags in 2024, out of which Arabica coffee 

is expected to increase by 8.8 per cent. 

Despite its historical prowess and current initiatives, the Sri Lankan coffee industry faces significant 

challenges, primarily in terms of production volume and consistency in quality. These challenges are 

further compounded by climate change, which presents new risks and opportunities for Arabica coffee 

cultivation in the region. The geographical and climatic conditions of Sri Lanka, while currently 

favourable for high-quality coffee production, are vulnerable to the erratic patterns and extremities 

proposed by climate change scenarios. 

Recent increases in private sector engagement have led to improvements in the quality of Sri Lankan 

coffee. This is supported by the public sector's recognition of coffee as a crop with substantial export 

potential. The Market Development Facility (MDF) has been instrumental since 2017 collaborating 

with various industry stakeholders including processors, collectors, traders, and the Lanka Coffee 

Association (LCA). MDF’s initiatives aim to enhance the quality and output of coffee, positioning Sri 

Lanka as a competitive exporter of specialty coffee, thereby generating substantial foreign exchange 

and elevating farmer incomes. 

This report will explore the potential impacts of climate change on Arabica coffee cultivation in Sri 

Lanka, examining both the vulnerabilities and the adaptive strategies necessary to sustain and expand 

this sector. The analysis will be focused on five key districts, including Matale, Kandy, Kegalle, Nuwara 

Eliya and Badulla (see Figure 1).  
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Figure 1: Five key districts considered for arabica suitability in Sri Lanka 

 

Ensemble-based climate model projections consider the following: 

- Variables: air temperature (mean, minimum and maximum), rainfall (mean and extreme 

rainfall), drought and tropical cyclones.   

- Time horizons: baseline (1970-2000), 2030 (2021-2040; short-term), 2050 (2041-2060; 

medium-term) and 2070 (2061-2080; long-term), monthly and annual. 

- Emission scenarios: SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) from 

the Coupled Model Intercomparison Project Phase 6 (CMIP6). 

 

Changes in the suitability of key growing conditions for coffee are also mapped, including changes in: 

1. Annual average temperatures between 18°C and 24°C  

2. Minimum air temperatures that exceed 15°C in January1  

3. Annual rainfall between 1500mm and 2750mm. 

 

1 Using Papua New Guinea as a proxy for Sri Lanka, coffee leaf rust (CLR; Hemileia vastatrix) incidence reaches a peak in May-July, and 
can result in yield losses. However, if the average January minimum temperature is less than 15°C, epidemic development (5 months 
later) is unlikely to reach levels which require chemical control (Brown et al. 1995). Average minimum temperatures below 15 degrees, 
thus serve to mitigate leaf rust risk. 
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2.2 Global climate model projections – an overview  

Downscaled projections2 for air temperature (mean, minimum and maximum) and precipitation have 

been extracted from WorldClim3. Projections use the latest generation CMIP6 modelling and 

downscaling and calibration (bias correction) was done with WorldClim v2.1 as a baseline climate 

(1970-2000) and considers a spatial resolution of 30 arc-seconds (approximately 1km resolution). For 

each climate change variable, an ensemble from 14 GCMs4 was derived, and projections were 

extracted for 2030 (average conditions between 2021-2040), 2050 (average conditions between 

2041-2060) and 2070 (average conditions between 2061-2080). Two future emission scenarios were 

modelled, including: 

• SSP1-2.6 (herein low-emissions future) – Low challenges to mitigation and adaptation. 

Emissions peak between 2040 and 2060 – even in the absence of specific climate policies. This 

results in 1.3-2.4°C of global warming by 2100 (see Figure 2) and approximately corresponds 

to the previous generation RCP2.6 scenario (Meinshausen et al. 2020).  

• SSP5-8.5 (herein high-emissions future) – High challenges to mitigation, low challenges to 

adaptation. SSP5-8.5 sees the most overall emissions of any SSP, resulting in global warming 

of 3.3-5.7°C (see Figure 2), marking the upper edge of the SSP scenario spectrum with a high 

reference scenario in a high fossil-fuel development world throughout the 21st Century 

(Meinshausen et al. 2020). 

 

 

Figure 2: Projected temperature changes (°C) according to five tier-one future emissions pathways from 

the IPCC 

 

 

 

2 Downscaled climate projections are localized climate models that refine global climate forecasts to provide high-resolution estimates 
of future climatic conditions at a regional or local scale. 
3 https://www.rccap.org/uploads/files/242aaafc-636c-42ba-967a-3081bd1adc6e/Coffee%20PNG%20Case%20Study%20Final.pdf  
4 GCMs included in the ensemble include: ACCESS-CM2, BCC-CSM2-MR, CMCC-ESM2, EC-Earth3-Veg, FIO-ESM-2-0, GFDL-ESM4, 
GISS-E2-1-G, HadGEM3-GC31-LL, INM-CM5-0, IPSL-CM6A-LR, MIROC6, MPI-ESM1-2-HR, MRI-ESM2-0, UKESM1-0-LL 
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The ensemble-based Global Climate Models (GCMs) assessed in this analysis often produce different 

and divergent projections for the same variable, climate change scenario and time horizon. As such, 

there is not a single projected future climate for the site but rather a range of plausible futures for a 

number of future scenarios. Throughout the report, the ensemble median (50th percentile) and 5th and 

95th percentile values are also reported to indicate the relative level of uncertainty for each climate 

change variable. 
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3. Climate projections summary for Sri Lanka 

3.1 Mean air temperature  

Consistent with global trends, future warming is expected across Sri Lanka. Projections for both 

warming scenarios indicate increases in mean air temperatures for all three future time horizons (Table 

1). For a low emissions future, mean temperatures are expected to increase by ~0.9°C by 2050 and 

~1.1°C by 2070. However, for a high emissions future, mean temperatures are expected to increase 

by 1.6°C and 2.6°C, respectively. Anomalies (difference from the baseline) for annual minimum and 

maximum temperature change are also consistent and expected to increase (see Appendix xx).  

Appendix A summarises annual temperature changes (mean, minimum, and maximum temperature 

changes) for each district. The associated data pack contains detailed raster files summarising monthly 

values for each district. Instructions on using these raster files in a GIS (QGIS or ArcMap) are included 

in Appendix C.  

Table 1: Mean temperature changes (absolute and anomalies) for five key districts (Matale, Kandy, Kegalle, 
Nuwara Eliya and Badulla) and Sri Lanka (entire) for SSP1-2.6 (low emissions future) for the baseline (1970-
2000), 2030, 2050 and 2070. Values represent the 50th percentile (p50) of the modelled ensemble.  

  
Low emissions future 

(SSP1-2.6) 
High emissions future 

(SSP5-8.5) 
  Absolute Anomaly Absolute Anomaly 

Badulla  

Baseline 24.1  24.1  
2030 24.9 +0.8 25.0 +0.9 
2050 25.2 +1.1 25.8 +1.7 
2070 25.3 +1.2 26.9 +2.8 

Kandy 

Baseline 23.7  23.7  
2030 24.4 +0.7 24.5 +0.8 

2050 24.7 +1.0 25.4 +1.7 
2070 24.9 +1.2 26.5 +2.8 

Kegalle 

Baseline 25.8  25.8  
2030 26.6 +0.8 26.7 +0.9 
2050 26.9 +1.1 27.5 +1.7 

2070 27.0 +1.2 28.6 +2.8 

Matale 

Baseline 25.7  25.7  
2030 26.4 +0.7 26.6 +0.9 
2050 26.7 +1.0 27.3 +1.6 
2070 26.9 +1.2 28.5 +2.8 

Nuwara 
Eliya 

Baseline 19.9  19.9  
2030 20.6 +0.7 20.7 +0.8 
2050 21.0 +1.1 21.5 +1.6 
2070 21.1 +1.2 22.6 +2.7 

Sri Lanka 
(entire) 

Baseline 26.7  26.7  
2030 27.3 +0.6 27.5 +0.8 
2050 27.6 +0.9 28.3 +1.6 

2070 27.8 +1.1 29.3 +2.6 
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Figure 3: Annual mean temperature change (°C) across Sri Lanka. The upper panel represents 
temperatures for the baseline (1970-2000), and the subsequent panels outline temperature change for 
SSP1-2.6 (low emissions future; left panels) and SSP5-8.5 (high emissions future; right panels) for 2030, 
2050 and 2070.   
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3.2 Rainfall 

In Sri Lanka, rainfall variability is influenced by several factors contributing to the variability of rainfall 

totals and changes in the seasonality of rainfall. Some key drivers of rainfall variability in Sri Lanka 

include: 

a. El Niño-Southern Oscillation (ENSO): ENSO is a global climate phenomenon characterised by 

periodic warming (El Niño) and cooling (La Niña) of the central and eastern tropical Pacific Ocean. 

In Sri Lanka, El Niño is typically associated with decreased rainfall, leading to drought conditions 

and affecting water availability, agriculture, and power generation. Conversely, La Niña often 

brings increased rainfall, enhancing water resources but also raising the risk of floods and 

landslides (Zubair et al., 2003). 

b. Indian Ocean Dipole (IOD): The IOD involves oscillations of sea-surface temperatures between 

the western and eastern parts of the Indian Ocean. During its positive phase, Sri Lanka may 

experience reduced rainfall, as cooler water in the eastern Indian Ocean can suppress convection 

and moisture flow towards the island, leading to drier conditions. The negative phase, 

characterised by warmer waters in the eastern Indian Ocean, tends to enhance rainfall in Sri Lanka, 

increasing the likelihood of enhanced monsoon rains and associated flooding (Gadgil et al., 2004). 

c. Topography and Terrain: Sri Lanka’s varied topography, including central highlands and coastal 

plains, plays a crucial role in determining local climate variations. Orographic lifting causes moist 

air masses to rise over the central highlands, resulting in higher rainfall in these areas. In contrast, 

areas in the shadow of these mountains, particularly in the northwestern and southeastern regions, 

receive less rainfall, illustrating the significant impact of topographic features on rainfall 

distribution across the island (de Silva, 2007). 

For Sri Lanka and many other nations around the world, CMIP6 models do not agree on the 

directionality of rainfall change and indicate that an increase or decrease in mean rainfall could occur. 

This means that for some scenarios, model medians can indicate little or no change. There is typically 

low confidence for rainfall projections. The impact of climate change may not be evident in the short 

or medium term due to the influences of intra-seasonal and inter-annual climate variability.  

3.2.1 Mean rainfall change  

Table 2 summarises the projected change in annual and seasonal rainfall across Sri Lanka. Generally, 

the ensemble median indicates an increase in annual rainfall, across all future time horizons and 

emission scenarios. Considering a low emissions future, mean annual rainfall (according to the 50th 

percentile) is expected to increase by between 6% and 9% between 2030 and 2070 (compared to the 

baseline). For a high emissions future, increases of between 5% and 13% are expected between 2030 

and 2070. Seasonally, increased rainfall is expected in all seasons except between March-May where 

less rainfall is expected.  

For Sri Lanka and around the world, CMIP6 models do not agree on the directionality of rainfall change 

and indicate that an increase or decrease in mean rainfall could occur. This means that model medians 

indicate little change for some scenarios or are inconsistent in trend between years and emission 

scenarios. The impact of climate change may not be obvious in the shorter term due to influences of 

intra-seasonal and inter-annual climate variability. The 5th-95th percentile values (anomalies expressed 
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as a % in parentheses; Table 2) highlight the disparity in future rainfall projections. As such, we have 

low confidence in rainfall projections.  

Figure 4 indicates the variability in annual rainfall projections across Sri Lanka between each time 

horizon and emission scenario analysed here. For more information on rainfall change across each 

municipality (see Appendix B) raster files summarising monthly changes are also available in the 

associated data pack. Instructions on using these raster files in a GIS (QGIS or ArcMap) are included in 

Appendix C.  
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Table 2: Annual and seasonal rainfall (absolute – mm; anomaly - %) for Sri Lanka for SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) for the 
baseline (1970-2000), 2030, 2050 and 2070. For projections excluding the baseline, upper values represent the 50th percentile (p50) of the ensemble and bottom 
values indicate the ensemble range (p5-p95). 

 

 

  Annual December-February March-May June-August September-November 

  
Absolute 

(mm) 
Anomaly 

(%) 
Absolute 

(mm) 
Anomaly 

(%) 
Absolute 

(mm) 
Anomaly 

(%) 
Absolute 

(mm) 
Anomaly 

(%) 
Absolute 

(mm) 
Anomaly 

(%) 

 Baseline 1883 - 505 - 431 - 265 - 682 - 

SSP1-2.6 
(low 
emissions 
future) 

2030 
1987 

(1661-
2334) 

6  
(-12 to 24) 

532 
(449-648) 

5  
(-11 to 28) 

422 
(349-483) 

-2  
(-19 to 12) 

288 
(255-326) 

9 
(-4 to 23) 

745 
(608-877) 

9 
(-11 to 29) 

2050 
2012 

(1657-
2363) 

7  
(-12 to 25) 

533 
(423-598) 

6  
(-16 to 18) 

410 
(344-504) 

-5  
(-20 to 17) 

295 
(245-361) 

11 
(-8 to 36) 

774 
(646-901) 

13 
(-5 to 32) 

2070 
2053 

(1693-
2463) 

9  
(-10 to 31) 

549 
(461-668) 

9  
(-9 to 32) 

419 
(343-508) 

-3  
(-20 to 18) 

298 
(253-362) 

12 
(-5 to 37) 

788 
(637-925) 

16 
(-7 to 36) 

SSP5-8.5 
(high 
emissions 
future) 

2030 
1980 

(1640-
2326) 

5  
(-13 to 24) 

513 
(412-631) 

2  
(-18 to 25) 

419 
(352-489) 

-3  
(-18 to 13) 

288 
(253-326) 

9 
(-5 to 23) 

760 
(622-880) 

11 
(-9 to 29) 

2050 
2041 

(1631-
2460) 

8  
(-13 to 31) 

539 
(432-661) 

7  
(-14 to 31) 

407 
(312-473) 

-6  
(-28 to 10) 

295 
(245-366) 

11 
(-8 to 38) 

800 
(642-959) 

17 
(-6 to 41) 

2070 
2125 

(1649-
2630) 

13  
(-12 to 40) 

541 
(449-640) 

7  
(-11 to 27) 

401 
(307-520) 

-7  
(-29 to 21) 

323 
(255-388) 

22 
(-4 to 46) 

861 
(639-
1082) 

26 
(-6 to 59) 
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Figure 4: Annual rainfall (mm) across Sri Lanka. The upper panel represents total annual rainfall for the 
baseline (1970-2000), and the subsequent panels outline annual rainfall (anomalies) for SSP1-2.6 (low 
emissions future; left panels) and SSP5-8.5 (high emissions future; right panels) for 2030, 2050 and 2070.   
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3.2.2 Extreme rainfall  

One way to quantify how extreme rainfall may change in the future is to use the well-established 

Clausius-Clapeyron (CC) relationship. The CC relationship suggests that per 1°C of annual maximum 

daily temperature change, there is a ~6.5% increase in extreme rainfall5 (Kharin et al. 2007; Pall et al. 

2007). Given uncertainties around rainfall projections and higher confidence in temperature-based 

projections, this is another method to quantify future changes in extreme rainfall. Equation 1 

summarises how to calculate future extreme rainfall: 

Extreme rainfall= ΔT x 6.5 [Eq. 1] 

Where: 

ΔT = projected change in annual air temperature (see Table 1). 

 

Recent research (Guerreiro et al. 2018) has identified “super CC” scaling, where anthropogenic climate 

change-induced changes to extreme rainfall are 1.5-3 times greater than changes expected based on 

the CC rate (see Eq. 1). This is particularly relevant for sub-daily storm durations (<24 hours). As such, 

it is important to consider the change in extreme rainfall using both CC and super CC approaches. 

Applying the CC rate to temperature changes across Sri Lanka (from Table 1), increases in extreme 

rainfall up to 8% for SSP1-2.6 (by 2070) and up to 18% for SSP5-8.5 (by 2070) (Table 3). Increases in 

the super CC rate are larger (e.g. up to 27% increase in extreme rainfall for SSP5-8.5 by 2070). Note 

that this is a high-level analysis and does not consider expected changes across multiple durations 

and return periods.  

Table 3: Ensemble median temperature change (ΔT; from Table 1) considering Clausius-Clapeyron (CC) 
scaling and super Clausius-Clapeyron (super CC) scaling (%).  

  Temperature 

change (ΔT) 

CC rate 

(% increase in 

extreme rain) 

Super CC rate  

(% increase in 

extreme rain) 

SSP1-2.6 

(low emissions 

future) 

2030 +0.6 4.2 6.3 

2050 +0.9 6.3 9.5 

2070 +1.1 7.7 11.6 

SSP5-8.5  

(high emissions 

future) 

2030 +0.8 5.6 8.4 

2050 +1.6 11.2 16.8 

2070 +2.6 18.2 27.3 

 

5 Extreme rainfall is a meteorological term used to describe precipitation events that significantly exceed established statistical 
thresholds for a specific location and time period. These events are rare and fall within the higher percentiles, often the 99th percentile, 
of a historical rainfall distribution. The definition can vary based on the region, the season, and the specific criteria used, such as 
intensity, duration, and total amount of rainfall. For instance, extreme rainfall can be quantified in terms of millimeters per hour 
(intensity), total millimeters over a day (amount), or the duration for which the rain persists. 



Future climate change scenarios and their implications for Arabica cultivation in Sri Lanka 
 

15 

  



Future climate change scenarios and their implications for Arabica cultivation in Sri Lanka 
 

16 

3.4 Drought 

Two primary types of drought may impact Sri Lanka: meteorological, usually associated with a 

precipitation deficit, and hydrological, typically linked to a deficit in surface and subsurface water flow. 

In the context of Sri Lanka, these droughts can significantly affect agriculture, water resources, and 

overall ecological stability. 

According to research by Manatsa and Mukwada (2018), projections indicate that with increasing 

global temperatures, Sri Lanka is expected to experience more frequent and severe meteorological 

droughts. These are primarily driven by anomalies in precipitation patterns linked to the El Niño-

Southern Oscillation (ENSO). During El Niño years, reduced rainfall is typical, exacerbating drought 

conditions. Conversely, La Niña years might not sufficiently offset the deficit due to the irregularity and 

intensity of these events. 

For hydrological droughts, studies suggest a complex interaction between local hydrological 

processes and broader climatic factors. Jayasuriya et al. (2015) highlight that changes in streamflow 

due to variable rainfall distributions and potentially increased evaporation rates may intensify 

hydrological droughts. These changes are particularly critical for Sri Lanka's extensive agricultural 

systems, which are reliant on consistent water supply from its river basins. 

Further, global warming projections indicate an increase in the severity and frequency of these 

drought types under high-emission scenarios. The standardized precipitation evaporation index (SPEI) 

is expected to fall below −2 more frequently, signaling severe drought conditions (Naumann et al., 

2018). However, these projections are marred by considerable uncertainty, with some climate models 

suggesting even more significant increases in future drought likelihood in Sri Lanka. 

 

3.5 Tropical cyclones  

Sri Lanka's geographic position off the southeastern coast of India provides it with some protection 

from the direct impact of tropical cyclones, which are more frequent in the Bay of Bengal. Historically, 

Sri Lanka experiences tropical cyclone effects indirectly, mostly in the form of heavy rainfall and strong 

winds. Between 1970 and 2020, several cyclones in the Bay of Bengal have impacted Sri Lanka, though 

generally with less intensity compared to their landfall in India or Bangladesh. 

There is strong scientific evidence suggesting that anthropogenic activities influence the magnitude, 

duration, and frequency of future tropical cyclone (TC) events. Estimating the effect of anthropogenic 

climate change on TC activity is complex due to the relatively short duration of detailed TC records 

and the limitations in global climate models (GCMs) which struggle to accurately resolve finer details 

of TC intensity (De Silva et al., 2019). 

For Sri Lanka specifically, while the frequency of cyclones might not significantly increase, the intensity 

of those that do affect the region is expected to intensify. This is consistent with broader global trends 

where, although the overall number of tropical cyclones may not rise, the proportion of high-intensity 

storms (categories 3-5) is expected to increase (IPCC, 2021). This scenario implies that even indirect 

impacts from cyclones in the Bay of Bengal could become more severe for Sri Lanka, necessitating 

enhanced preparedness and adaptive measures. 
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4. Projected climate hazard-based impacts on 
the coffee sector in Sri Lanka  

Expanding upon the climate change projections presented in Section 2, this section seeks to 

quantitatively assess the expected consequences of climate change on Arabica cultivation in Sri Lanka. 

The objective is to investigate how shifts in climate conditions best suited for coffee cultivation might 

affect the viability of growing coffee across the following five Arabica-growing districts: Matale, Kandy, 

Kegalle, Nuwara Eliya, and Badulla.  

4.1 Methodology and assumptions 

This analysis uses suitability analysis to investigate the potential impacts of climate change on Arabica 

cultivation across five key growing districts in Sri Lanka. A literature review has highlighted that optimal 

coffee cultivation is dependent on the following criteria: 

1. Annual average temperatures (18°C-24°C): Annual average temperatures between 18°C and 

24°C. Annual average temperatures <18°C are considered too cold, and >24°C are 

considered too warm (Sri Lankan Department of Export Agriculture, 2024) 

2. Minimum air temperatures (exceeding 15°C in January): Incidence of coffee leaf rust is a 

particular issue in Sri Lanka. Using insights from Papua New Guinea, Coffee Leaf Rust (CLR; 

Hemileia vastatrix) incidence reaches a peak in May-July and can result in yield losses, and 

particularly impacts Robusta. However, if the average January minimum temperature is less 

than 15°C, epidemic development (5 months later) is unlikely to reach levels which require 

chemical control (Brown et al. 1995). Average minimum temperatures in January below 15 

degrees, thus serve to mitigate CLR risk.  

3. Annual rainfall (1500-2750 mm per annum): Specific to Sri Lanka, the rainfall range of 1500-

2750mm is considered to be optimal for Arabica cultivation (Sri Lankan Department of Export 

Agriculture, 2024). However, this is in contrast to regional and global ranges of suitable annual 

rainfall, including 1700-5000mm (Bourke and Harwood 2009) and 1500-3000mm with 2000-

3000mm as the optimum range (Taylor et al. 2016). Considering the variability and uncertainty 

associated with rainfall projections, the outcomes from these criteria should be considered 

indicative only.  

These criteria are modelled for both low emissions (SSP1-2.6) and high emissions (SSP5-8.5) scenarios 

across four time periods (present, 2030, 2050 and 2070). The % of land area at risk (where conditions 

fall outside of the respective optimum range), or % of land area where conditions are optimal, is 

calculated for each district. 

4.2 Air temperature  

4.2.1 How will annual average temperature change impact coffee cultivation?  

Regardless of future emission scenario and time horizon, most districts experience a reduction in land 

area where annual average temperatures are optimal for coffee cultivation (18-24°C), except for 

Nuwara Eliya. This is due to annual average temperatures exceeding the upper optimum temperature 
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threshold (24°C). The following narrative is focused on the five primary Arabica-producing districts as 

per Table 5 and Figure 5 (see Appendix D for detailed suitability statistics for each district):   

a. Badulla: In the baseline scenario6, 41% of Badulla's land area experiences optimal annual average 

temperatures. Decreases in suitability are observed across both emission scenarios (driven by 

expected warming air temperatures), particularly for a high-emissions future, where the 

percentage of suitable area decreases by 3% (2030), 10% (2050), and 19% (2070).  

b. Kandy: Around 50% of Kandy in the baseline scenario sees optimal annual average temperatures. 

Decreases in suitability are observed for both emission scenarios. For a low emissions scenario, 

the land area with optimal temperatures decreases by 13% (2030), 19% (2050) and 21% (2070). 

For a high emissions future, reductions are more material: 15% (2030), 27% (2050) and 39% (2070) 

observed. 

c. Kegalle: Only 9% of Kegalle sees optimum rainfall in the baseline, which is expected to reduce 

across all future emission scenarios. Reductions of 2% (2030) and 3% (2070) are expected for a 

low-emissions future, and 2% (2030) and 7% (2090) are expected for a high-emissions future.  

d. Matale: In the baseline scenario, 12% of Matale's land area sees optimal annual average 

temperatures, and this decreases under all future emissions scenarios and time horizons. A slight 

reduction is observed under a low emissions future, with up to a 5% reduction by 2070. This is 

more significant for a high emissions future, with a 10% reduction in land with optimal rainfall.  

e. Nuwara Eliya: Of all districts, Nuwara Eliya has the highest % of land area with optimal 

temperature. It is the only district to see an increase in area, with up to a 5% increase by 2070 (low 

emissions future) and a 4% increase by 2070 (high emissions future).  

Table 4: Percentage (%) of land area where annual average temperatures are optimal for coffee cultivation 

(18-24°C). All areas indicate a decline, except where donated by a green arrow.  

  
SSP1-2.6 

(Low emissions future) 
SSP5-8.5 

(High emissions future) 

District 

Baseline 
(1970-2000) 
% of area - 

optimal 

2030 
% of 

area -
optimal 

2050 
% of 

area - 
optimal 

2070 
% of 

area - 
optimal 

2030 
% of 

area - 
optimal 

2050 
% of 

area - 
optimal 

2070 
% of 

area - 
optimal 

Badulla 41 39 37 36 38 31 22 

Kandy 50 37 31 29 35 23 11 

Kegalle 9 7 6 6 7 5 2 

Matale 12 9 7 7 8 5 2 

Nuwara 
Eliya 

63 ↑67 ↑68 ↑68 ↑67 ↑69 ↑67 

 

 

6 The baseline is the average between 1970 and 2000.  
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Figure 5: Suitability map of five key Arabica growing districts in Sri Lanka outlining areas that are too cold 
(<18°C), suitable (18-24°C) and too warm (>24°C) for coffee cultivation (annual average temperature) for 
the baseline (1970-2000; top panel), and future emission scenarios including SSP1-2.6 (left panels) and 
SSP5-8.5 (right panels) for 2030, 2050 and 2070, considering p50.  
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4.2.2 How will changes in average minimum temperatures in January impact 
disease?  

Table 5 highlights that the majority of districts are already at high risk of CLR in the baseline (where 

average minimum January temperatures are optimal at less than or equal to 15°C). For Kandy, Kegalle 

and Matale, >90% of the area is at risk of CLR, both in the baseline and for every future scenario, as 

minimum January temperatures exceed 15°C.  

For the baseline, modelling has indicated that Nuwara Eliya is the least at risk of CLR, with 70% of the 

area at low risk of CLR. However, this changes significantly in the future, and by 2070 reduces to 56% 

(low emissions future) and 34% (high emissions future). See Appendix E for detailed suitability statistics 

for each municipality. 

Table 5: Percentage (%) of land area where average minimum temperatures in January are at lower risk of 
CLR (where average minimum January temperatures <=15°C) defined as ‘optimal’.  

  
SSP1-2.6 

(Low emissions future) 
SSP5-8.5 

(High emissions future) 

District 

Baseline 
(1970-
2000) 

% of area – 
lower risk 

2030 
% of area 

– lower 
risk 

2050 
% of area 

– lower 
risk 

2070 
% of area 

– lower 
risk 

2030 
% of area 

– lower 
risk 

2050 
% of area 

– lower 
risk 

2070 
% of area 

– lower 
risk 

Badulla 20 10 8 7 10 5 3 

Kandy 10 5 4 4 5 2 0 

Kegalle 2 1 1 1 1 0 0 

Matale 2 1 1 1 1 0 0 

Nuwara 
Eliya 

70 60 58 56 60 46 34 
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Figure 6: Suitability map of five key Arabica growing districts in Sri Lanka outlining areas that are at lower 
and higher risk of CLR. Lower (higher) CLR risk is calculated where minimum January temperatures <=15°C 
(>15°C) for the baseline (1970-2000; top panel), and future emission scenarios including SSP1-2.6 (left 
panels) and SSP5-8.5 (right panels) for 2030, 2050 and 2070, considering p50.  
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4.3 Annual average rainfall 

4.3.1 How will changes in annual rainfall impact areas suitable for coffee cultivation?  

Before interpreting the results in Table 6 and 

Figure 7, it is important to note, as highlighted above in Section 2, that there is considerable 

uncertainty in global future rainfall projections. Table 6 indicates that for three of five districts (Kandy, 

Kegalle and Nuwara Eliya), the land area with optimal rainfall (1500-2750mm) is declining. 

Considering a low emissions future for Kandy, Kegalle and Nuwara Eliya, reductions of up to 12% are 

modelled by 2070, and up to 15% for a high emissions future by 2070.   

In the baseline and considering all future emission scenarios and time horizons, Badulla and Matale 

see at least 99% of land area within the optimum rainfall range.  

The impact of interannual climate variability (e.g. ENSO and the IOD) on rainfall are more likely to 

induce significant shorter-term impacts (e.g. drought or intense rainfall) that impacts production and 

challenges growers. This variability, including phenomena such as the El Niño and La Niña cycles, can 

abruptly alter precipitation patterns, creating conditions that may stress coffee plants or foster 

environments conducive to pests and diseases. These short-term climate variations may result in more 

volatile coffee yields, affecting the harvest's quantity and quality, as well as impacting coffee flowering, 

processing and transport. 

Table 6: Percentage (%) of land area where annual average rainfall is optimal for coffee cultivation (1500-
2750mm per year). All areas indicate a decline except where donated by a green arrow. 

 

  

  
SSP1-2.6 

(Low emissions future) 
SSP5-8.5 

(High emissions future) 

District 

Baseline 
(1970-2000) 
% of area - 

optimal 

2030 
% of 

area - 
optimal 

2050 
% of 

area - 
optimal 

2070 
% of 

area - 
optimal 

2030 
% of 

area - 
optimal 

2050 
% of 

area - 
optimal 

2070 
% of 

area - 
optimal 

Badulla 99 ↑100 ↑100 ↑100 ↑100 ↑100 ↑99 

Kandy 84 77 76 72 78 75 69 

Kegalle 17 10 8 6 9 8 3 

Matale 100 ↑100 ↑100 ↑100 ↑100 ↑100 ↑100 

Nuwara 
Eliya 

74 68 66 63 66 65 60 
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Figure 7: Suitability map of five key Arabica growing districts in Sri Lanka outlining areas with optimum 
mean annual rainfall (1500-2750mm) for the baseline (1970-2000; top panel), and future emission scenarios 
including SSP1-2.6 (left panels) and SSP5-8.5 (right panels) for 2030, 2050 and 2070, considering p50. 
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5. Uncertainties and limitations 

The uncertainties and limitations with the modelling contained in this report include: 

1. Climate Model and emission scenario uncertainty: The analysis relies on ensemble-based 

climate model projections. These models often produce projections that diverge in 

directionality and magnitude for the same variables, climate change scenarios, and time 

horizons. This model uncertainty means there is not a single projected future climate for the 

site but rather a range of plausible futures for different scenarios. The analysis considers two 

emission scenarios, a low emissions future (SSP1-2.6) and high emissions future (SSP5-8.5), 

each of which represents different levels of greenhouse gas emissions and climate policies.  

2. Suitability: In demonstrating the impact of climate change projections on coffee cultivation, 

this report has used temperature and rainfall ranges or thresholds that the research and 

literature suggest are suitable or ‘optimal’ for growing Arabica. As future climate projections 

indicate shifts in climatic factors, the districts traditionally suitable for Arabica cultivation may 

experience changes, necessitating adaptation in farming practices. Regarding the distinction 

between suitability and possibility, suitability refers to the traditional climatic conditions 

considered most suitable for coffee growth, encompassing specific temperature and rainfall 

ranges or thresholds that have been established over time. As future climate projections 

suggest shifts in these climatic factors, the districts or areas traditionally suitable for coffee 

cultivation may experience changes, necessitating adaptation in farming practices. 

Conversely, possibility explores the capacity to cultivate coffee in regions or under conditions 

that deviate from these established norms. It considers the potential to maintain coffee 

production with the aid of adaptation, including technological innovations and advanced 

agricultural techniques, including improved water management systems or the development 

of varietals that can withstand less favourable conditions. This distinction acknowledges that 

while climate projections indicate regions may be less suitable for cultivation using the defined 

thresholds, challenges could be overcome through strategic adaptation and resilience in 

farming practices. 

3. Climate variability vs. climate change: Compared to long-term climate changes, climate 

variability can often present more immediate and impactful challenges. While long-term 

climate change sets the overarching trajectory for shifts in coffee-growing regions, potentially 

rendering some areas more or less suitable over time, it is the shorter-term climate variability 

that impacts extremes and introduces acute stressors to coffee production. These fluctuations 

can manifest as sudden droughts or extreme rainfall that lead to crop damage in the immediate 

season and increased vulnerability to pests and diseases. The sporadic nature of these extreme 

events makes them particularly disruptive, as they do not allow for the gradual adaptation of 

agricultural practices.  

4. Influence of non-climatic Factors: The analysis focuses on climate change and does not 

consider other non-climatic factors (e.g. farming practices, soil quality, pests, and diseases 

(beyond CLR)). The composition and fertility of the soil, for instance, are critical for coffee 

plants, influencing root health, nutrient uptake, and the ability of the plant to support 

productive coffee cherries. Inadequate soil conditions can diminish plant vigour and yield, 

irrespective of favourable climatic conditions. Meanwhile, Pests and diseases pose a constant 
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threat to coffee crops; examples include the Coffee Berry Borer (CBB) and CLR, which can 

devastate coffee plantations. These biological challenges are influenced by a variety of factors, 

including farming practices, landscape diversity, and the presence of natural pest predators. 

The impact of such non-climatic factors is significant, often necessitating extensive research 

and investment into pest-resistant coffee plant varieties, soil amendment practices, and 

integrated pest management strategies. Together, these factors are just as critical as climate 

considerations and must be integrated into any comprehensive approach to sustainable coffee 

cultivation. 

5. Coffee Berry Borer (CBB) modelling: Climate change, particularly temperature increases, can 

exacerbate the incidence of Coffee Berry Borer (CBB) in coffee plantations globally, including 

Sri Lanka (Groenen, 2018). Poor farm management and a lack of biological diversity elevate 

pest outbreaks (Teodoro et al., 2008). A rise in average daily temperatures above 26°C could 

curtail CBB activity (Jaramillo et al., 2009), but a 1°C increase in regions with average daily 

temperatures below 26.7°C would amplify the rate of CBB increase by around 8.5% (Jaramillo 

et al., 2009). This could significantly influence pest dynamics, leading to increased pest 

pressure in regions with higher seasonal temperatures. Furthermore, rising temperatures 

could extend the CBB's geographic and altitudinal range, including regions with high-quality 

Arabica coffee, making it challenging to cultivate coffee in these areas (Jaramillo et al., 2011). 

In summary, while the analysis provides valuable insights into the potential impacts of climate change 

on coffee cultivation in Sri Lanka, it is important to recognise and consider the various uncertainties 

and limitations inherent in the methodology and data sources used. These uncertainties should be 

taken into account when interpreting the results and informing further analysis and decisions based 

on the analysis. 
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6. Conclusions and adaptation  

Climate change is expected to impact the coffee industry across Sri Lanka. Changes in air 

temperatures and rainfall (annual totals, seasonal variability, and extreme events) are likely to influence 

the conditions best suited for Arabica cultivation, potentially impacting coffee quality and yield 

potential. These changes present challenges that, through forward planning and adaptive capacity 

development, may be managed to minimise risk and impact and potentially present opportunities for 

emerging producers.  

Suitability analysis of three conditions known to influence Arabica cultivation highlighted: 

• Average annual temperatures: The analysis of annual average temperatures across Sri Lanka 

reveals notable shifts in areas with optimal temperatures for Arabica production. Optimal 

conditions are, of course, further determined by other non-climatic factors, including altitude, 

orientation, soil type, etc. For most of the five key Arabica growing districts, low (SSP1-2.6) and 

high (SSP5-8.5) emission scenarios predict a declining trend in optimal growing area based on 

temperature alone. For Badulla, Kandy, Kegalle, and Matale, increasing air temperatures results 

in a reduction in the area that is optimal for Arabica production. For some districts, such as 

Kandy, declines are material. At present, 50% of Kandy has optimal average annual 

temperatures for Arabica, but this declines to 29% (11%) by 2070, considering a low emissions 

(high emissions) future. However, for Nuwara Eliya, the region sees an increase area of the 

district with optimal temperatures, increasing from 63% in the baseline (1970-2000) to 67-68% 

by 2070 (emission scenario depending). Based on average annual temperatures alone, this 

may represent an opportunity for Arabica cultivation in Nuwara Eliya.  

• January minimum temperatures: The five primary districts cultivating Arabica coffee are facing 

an increased threat of Coffee Leaf Rust (CLR), due to January temperatures consistently 

exceeding 15°C. CLR is likely already widespread in Kegalle and Matale, where approximately 

98% of the land area has been experiencing these temperatures since the 1970-2000 baseline 

period. Projected temperature increases imply that this trend is expected to persist. Currently, 

Nuwara Eliya presents a lower CLR risk due to its cooler climate. However, as the rise in 

temperatures is anticipated, this risk is projected to escalate, as warmer conditions are more 

conducive to CLR. 

• Annual rainfall: For three of five districts (Kandy, Kegalle and Nuwara Eliya), the land area with 

optimal rainfall (1500-2750mm) is declining. Considering a low emissions future for Kandy, 

Kegalle and Nuwara Eliya, reductions of up to 12% are modelled by 2070, and up to 15% for 

a high emissions future by 2070.  However, for Badulla and Matale, minimal change is 

anticipated across modelled emission scenarios and time horizons, where at least 99% of the 

land area falls within the optimum annual rainfall range. The impact of interannual climate 

variability (e.g. ENSO and the IOD) on rainfall are more likely to induce significant short-term 

fluctuations in coffee cultivation, leading to erratic production issues that challenge growers. 

These short-term climate perturbations, in addition to shorter-duration extreme rainfall events, 

may impact both the quantity and quality of the harvest. 

Changes in other climatic factors (summarised in Section 2 but not included in the modelling in Section 

3), including extreme rainfall, increases in extreme heat, changes in the sequence of rainfall (wet and 
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dry day sequences) and changes in drought risk may introduce other, compounding and interrelated 

challenges for the coffee industry. These include but are not limited to, fungal diseases, drainage 

issues and soil erosion, all of which have the potential to impact coffee cultivation.  

Based on certain suitability metrics, the future for some districts appears promising for Arabica 

cultivation amidst climate change. This potential adaptability extends from Arabica farming to all 

associated processes, potentially leading to a more robust coffee industry. By understanding which 

climate variables can be more easily adapted to, strategies can be developed to leverage the 

changing climate, resulting in opportunities for growth and development in the Arabica farming 

sector. 

As detailed in this report, the coffee sector in Sri Lanka is exposed to and sensitive to a range of future 

climate-driven pressures. The ability of the coffee sector in Sri Lanka to cope with these emerging 

pressures and risks will be determined by a complex range of interacting social, economic, and 

biophysical factors.  

There are a number of adaptation measures that coffee producers and stakeholders across Sri Lanka 

could implement to manage these risks and enhance their resilience to climate change:  

1. Diversify coffee varieties: explore and cultivate coffee varieties that are more resilient to 

climate change, such as those with temperature, drought and disease resistance.  

2. Water management: invest in water management systems including improved catchment 

management and irrigation to counteract water scarcity during prolonged dry seasons. 

3. Explore new coffee-growing areas: as climate change continues to impact Sri Lanka, 

previously unsuitable areas may become more conducive to coffee cultivation. Existing and 

competing land use priorities will need to be managed. 

4. Soil conservation: implement soil conservation techniques to maintain soil health and prevent 

erosion, ensuring coffee plant roots are less vulnerable to temperature and moisture 

fluctuations.  

5. Pest and disease control: develop integrated pest and disease management strategies to 

address the changing patterns of coffee pests and diseases brought on by climate change (e.g. 

CLR, CBB, and other diseases).  

6. Research and development: invest in research to explore innovative agricultural techniques to 

ensure that present coffee producing regions can continue to grow coffee well into the future.  

7. Access to finance: facilitate access to financial resources to assist farmers with adaptation, 

including using cooperative insurance as a method to transfer risk. 

8. Collaboration and networking: foster cooperation and information exchange among coffee 

farmers, cooperatives, and the government to share knowledge and best practices in climate 

adaptation. 

9. Climate early warning and monitoring: utilise climate and weather forecast information to 

provide seasonal outlooks to inform planning and decision-making and enhance climate 
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monitoring capabilities and networks, such as weather monitoring stations to inform planning 

in the short and long term.  

10. Education and training: provide farmers with training and resources to help them understand 

how the climate is expected to change, how they can access support and assistance, and ways 

that they can implement some of the recommendations outlined in this report.  

These and other adaptive capacity and resilience-building measures would need to be considered 

with reference to the context-specific analysis of the Arabica sector in Sri Lanka. Regardless, as the 

climate continues to change, “quick-win” and no-regrets adaptation should be explored and 

implemented where possible.  
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Appendix A: Detailed temperature projections  

Table A1: Mean temperature changes (absolute; °C) for Sri Lanka for SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) for the baseline, 2030, 

2050 and 2070. For projections excluding the baseline, upper values represent the 50th percentile (p50) of the ensemble, and bottom values indicate the 

ensemble range (p5-p95). 

  
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 
Baseline 
(1970-
2000) 

2030 2050 2070 2030 2050 2070 

Badulla 24.1 
24.9 

(24.7 to 25.4) 
25.2 

(24.9 to 25.8) 
25.3 

(25.0 to 26.0) 
25.0 

(24.8 to 25.5) 
25.8 

(25.4 to 26.7) 
26.9 

(26.1 to 27.8) 

Kandy 23.7 
24.4 

(24.3 to 25.0) 
24.7 

(24.5 to 25.4) 
24.9 

(24.6 to 25.6) 
24.5 

(24.4 to 25.1) 
25.4 

(25.0 to 26.3) 
26.5 

(25.7 to 27.4) 

Kegalle 25.8 
26.6 

(26.4 to 27.1) 
26.9 

(26.6 to 27.5) 
27.0 

(26.7 to 27.8) 
26.7 

(26.5 to 27.2) 
27.5 

(27.1 to 28.4) 
28.6 

(27.8 to 29.5) 

Matale 25.7 
26.4 

(26.3 to 27.0) 
26.7 

(26.5 to 27.4) 
26.9 

(26.6 to 27.7) 
26.6 

(26.4 to 27.1) 
27.3 

(27.0 to 28.3) 
28.5 

(27.7 to 29.4) 

Nuwara 
Eliya 

19.9 
20.6 

(20.5 to 21.2) 
21.0 

(20.7 to 21.6) 
21.1 

(20.8 to 21.8) 
20.7 

(20.6 to 21.2) 
21.5 

(21.2 to 22.4) 
22.6 

(21.9 to 23.5) 

Sri Lanka 26.7 
27.3 

(27.2 to 27.9) 
27.6 

(27.4 to 28.3) 
27.8 

(27.5 to 28.6) 
27.5 

(27.3 to 28.0) 
28.3 

(27.9 to 29.2) 
29.3 

(28.6 to 30.3) 
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Table A2: Minimum temperature changes (absolute; °C) for Sri Lanka for SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) for the baseline, 

2030, 2050 and 2070. For projections excluding the baseline, upper values represent the 50th percentile (p50) of the ensemble, and bottom values indicate the 

ensemble range (p5-p95). 

  
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 
Baseline 
(1970-
2000) 

2030 2050 2070 2030 2050 2070 

Badulla 20.2 
21.1 

(20.8 to 21.5) 
21.3 

(21.0 to 22.0) 
21.4 

(20.9 to 22.3) 
21.1 

(20.8 to 21.7) 
21.9 

(21.5 to 22.9) 
22.8 

(22.1 to 24.1) 

Kandy 19.6 
20.5 

(20.2 to 21.0) 
20.8 

(20.4 to 21.4) 
20.8 

(20.5 to 21.7) 
20.6 

(20.3 to 21.1) 
21.4 

(20.9 to 22.3) 
22.3 

(21.6 to 23.5) 

Kegalle 22.1 
23.0 

(22.7 to 23.4) 
23.2 

(22.9 to 23.9) 
23.3 

(22.9 to 24.2) 
23.0 

(22.8 to 23.6) 
23.8 

(23.4 to 24.8) 
24.8 

(24.1 to 25.9) 

Matale 21.6 
22.5 

(22.2 to 22.9) 
22.7 

(22.4 to 23.4) 
22.8 

(22.4 to 23.7) 
22.5 

(22.3 to 23.1) 
23.3 

(22.9 to 24.3) 
24.3 

(23.6 to 25.4) 

Nuwara 
Eliya 

15.8 
16.7 

(16.4 to 17.2) 
17.0 

(16.6 to 17.7) 
17.0 

(16.7 to 17.9) 
16.8 

(16.5 to 17.3) 
17.6 

(17.1 to 18.5) 
18.5 

(17.8 to 19.7) 

Sri Lanka 22.9 
23.8 

(23.5 to 24.2) 
24.0 

(23.7 to 24.7) 
24.1 

(23.6 to 25.0) 
23.8 

(23.5 to 24.4) 
24.6 

(24.1 to 25.6) 
25.5 

(24.8 to 26.7) 
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Table A3: Maximum temperature changes (absolute; °C) for Sri Lanka for SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) for the baseline, 

2030, 2050 and 2070. For projections excluding the baseline, upper values represent the 50th percentile (p50) of the ensemble, and bottom values indicate the 

ensemble range (p5-p95). 

  
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 
Baseline 
(1970-
2000) 

2030 2050 2070 2030 2050 2070 

Badulla 28.1 
28.9 

(28.5 to 29.3) 
29.2 

(28.8 to 29.8) 
29.3 

(28.8 to 29.9) 
29.0 

(28.6 to 29.4) 
29.8 

(29.1 to 30.5) 
30.8 

(29.6 to 31.6) 

Kandy 27.8 
28.6 

(28.2 to 29.1) 
29.0 

(28.4 to 29.5) 
29.0 

(28.4 to 29.6) 
28.7 

(28.3 to 29.1) 
29.5 

(28.9 to 30.2) 
30.6 

(29.4 to 31.4) 

Kegalle 29.6 
30.4 

(30.2 to 30.8) 
30.8 

(30.5 to 31.3) 
30.8 

(30.5 to 31.4) 
30.5 

(30.4 to 30.9) 
31.3 

(30.9 to 32.0) 
32.4 

(31.5 to 32.2) 

Matale 29.9 
30.7 

(29.6 to 31.1) 
31.1 

(29.8 to 31.6) 
31.1 

(29.8 to 31.7) 
30.8 

(29.7 to 31.2) 
31.6 

(30.2 to 32.3) 
32.7 

(30.8 to 33.4) 

Nuwara 
Eliya 

24.0 
24.8 

(24.4 to 25.2) 
25.1 

(24.6 to 25.6) 
25.2 

(24.6 to 25.8) 
24.9 

(24.5 to 25.2) 
25.6 

(25.1 to 26.4) 
26.7 

(25.6 to 27.5) 

Sri Lanka 30.4 
31.2 

(30.8 to 31.6) 
31.5 

(31.0 to 32.1) 
31.6 

(31.0 to 32.3) 
31.3 

(30.8 to 31.7) 
32.1 

(31.4 to 32.8) 
33.1 

(32.0 to 33.9) 
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Appendix B: Detailed rainfall projections 

Table B1: Annual rainfall (absolute; mm) for Sri Lanka for SSP1-2.6 (low emissions future) and SSP5-8.5 (high emissions future) for the baseline, 2030, 2050 and 
2070. For projections excluding the baseline, upper values represent the 50th percentile (p50) of the ensemble, and bottom values indicate the ensemble range 
(p5-p95). 

 
 

 
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 
Baseline 
(1970-
2000) 

2030 2050 2070 2030 2050 2070 

Badulla 1899 
1990 

(1666 to 2339) 
2008 

(1666 to 2348) 
2049 

(1729 to 2426) 
1983 

(1640 to 2353) 
2031 

(1664 to 2466) 
2117 

(1654 to 2607) 

Kandy 2384 
2515 

(2081 to 2940) 
2544 

(2017 to 2980) 
2607 

(2107 to 3100) 
2498 

(2026 to 2942) 
2567 

(2017 to 3111) 
2674 

(2094 to 3346) 

Kegalle 3433 
3629 

(3016 to 4199) 
3682 

(2903 to 4397) 
3770 

(3036 to 4524) 
3677 

(2981 to 4285) 
3723 

(2882 to 4559) 
3944 

(3010 to 5060) 

Matale 1867 
1974 

(1654 to 2334) 
1991 

(1635 to 2303) 
2035 

(1670 to 2434) 
1929 

(1607 to 2290) 
2016 

(1616 to 2415) 
2070 

(1640 to 2549) 

Nuwara 
Eliya 

2481 
2617 

(2154 to 3040) 
2649 

(2085 to 3132) 
2717 

(2183 to 3225) 
2636 

(2113 to 3082) 
2673 

(2088 to 3269) 
2815 

(2185 to 3560) 

Sri Lanka 1883 
1987 

(1661 to 2334) 
2012 

(1657 to 2363) 
2053 

(1693 to 2463) 
1980 

(1640 to 2326) 
2041 

(1631 to 2460) 
2125 

(1649 to 2630) 
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Appendix C: Instructions on using GIS to 
interrogate climate modelling data  

Instructions on using QGIS 

Step 1: Launch QGIS 

1. Begin by launching the QGIS software on your computer. 

Step 2: Load Geotiff Files 

2. Click on the “Add Raster Layer” button located in the toolbar or go to ‘Layer’> ‘Add Layer’> 

‘Add Raster Layer’ in the menu. 

3. In the “Data Source Manager” dialog box, click the “...” button to browse for the geotiff files 

you want to interrogate. Select the relevant absolute and anomalous climate change projection 

files for Sri Lanka. Click “Open.” 

4. The selected geotiff files will be added as layers to the QGIS canvas. 

Step 3: Explore the Data 

5. To visualise the data, ensure that the added geotiff layers are listed in the “Layers Panel” on 

the left side of the QGIS interface. You can turn layers on and off by checking or unchecking 

the corresponding checkboxes. 

6. Adjust the symbology and colour representation of the layers as needed to highlight specific 

climate variables or anomalies. Right-click on a layer, select “Properties,” and navigate to the 

“Symbology” tab to modify the styling options. 

Step 4: Interrogate the Data 

7. To interrogate the values of the raster layers, follow these detailed steps: 

a. Ensure the desired geotiff layer is selected in the “Layers Panel.” 

b. Click on the “Identify Features” button located in the toolbar or go to ‘View’> ‘Identify Features’ 

to activate the tool. 

c. Once the “Identify Features” tool is active, you can now click anywhere on the map within the 

selected layer. 

d. A dialog box will appear displaying detailed information about the pixel or cell you clicked on. 

This information includes: 

• The geographic coordinates (latitude and longitude) of the clicked point. 

• The value of the raster cell at that location represents climate data such as temperature, 

precipitation, or anomalies. 

• Any additional attributes associated with that pixel, depending on the specific geotiff layer. 
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e. You can repeat this process by clicking on different locations within the layer to extract values 

at various points on the map. 

f. To view more detailed information or export the values, you can click the “Copy to Clipboard” 

button or use the “Save Feature As” option to export the information to a file. 

Step 5: Save Data 

8. If you wish to extract specific data from the geotiff layers, use the “Export” or “Save As” 

functionality in QGIS. Right-click on a layer in the “Layers Panel,” choose “Export” or “Save As,” 

and specify the desired format (e.g., CSV, GeoJSON) and location for saving the data. 

 

Instructions on using ArcMap 

Step 1: Launch ArcMap 

1. Begin by launching the ArcMap software on your computer. 

Step 2: Load Geotiff Files 

2. Go to ‘File’> ‘Add Data’> ‘Add Data...’ in the menu. 

3. In the “Add Data” dialog box, browse for the geotiff files you want to interrogate. Select the 

relevant absolute and anomalous climate change projection files for Sri Lanka. Click “Add.” 

4. The selected geotiff files will be added as layers to the ArcMap workspace. 

Step 3: Explore the Data 

5. To visualise the data, ensure that the added geotiff layers are listed in the “Table of Contents” 

on the left side of the ArcMap interface. You can turn layers on and off by checking or 

unchecking the corresponding checkboxes. 

6. Adjust the symbology and colour representation of the layers as needed to highlight specific 

climate variables or anomalies. Right-click on a layer, select “Properties,” and navigate to the 

“Symbology” tab to modify the styling options. 

Step 4: Interrogate the Data 

7. To interrogate the values of the raster layers, follow these detailed steps: 

a. Ensure the desired geotiff layer is selected in the “Table of Contents.” 

b. Click on the “Identify” button located in the toolbar or go to ‘Tools’> ‘Identify’ to activate the tool. 

c. Once the “Identify” tool is active, you can now click anywhere on the map within the selected layer. 

d. A pop-up window will appear displaying detailed information about the pixel or cell you clicked 

on. This information includes: 

• The geographic coordinates (latitude and longitude) of the clicked point. 
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• The value of the raster cell at that location, which represents climate data such as 

temperature, precipitation, or anomalies. 

• Any additional attributes associated with that pixel, depending on the specific geotiff 

layer. 

e. You can repeat this process by clicking on different locations within the layer to extract values at 

various points on the map. 

f. To view more detailed information or export the values, you can click the “Copy” button or use the 

“Export Data” option to export the information to a file. 

Step 5: Save Data 

8. If you wish to extract specific data from the geotiff layers, use the “Export Data” functionality in 

ArcMap. Right-click on a layer in the “Table of Contents,” choose “Data”> “Export Data,” and 

specify the desired format (e.g., CSV, Excel) and location for saving the data. 
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Appendix D. Suitability analysis – annual average temperatures  

Table D1: Percentage (%) of land area where annual average temperatures are too cold (<18°C), suitable (18-24°C) and too warm (>24°C) for coffee cultivation 
(considering p50 for future scenarios). 

 

  
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 

Baseline 
(1970-2000) 

2030 2050 2070 2030 2050 2070 

Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 
Too 
cool 

Suitable 
Too 

warm 

Badulla 2 41 56 2 39 60 1 37 62 1 36 63 2 38 61 1 31 68 0 22 78 

Kandy 0 50 50 0 37 63 0 31 69 0 29 71 0 35 65 0 23 77 0 11 89 

Kegalle 0 9 91 0 7 93 0 6 94 0 6 94 0 7 93 0 5 95 0 2 98 

Matale 0 12 88 0 9 91 0 7 93 0 7 93 0 8 92 0 5 95 0 2 98 

Nuwara 
Eliya 

27 63 10 19 67 14 16 68 16 15 68 17 18 67 15 10 69 21 3 67 30 
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Appendix E. Suitability analysis – minimum January temperatures  

Table E1: Percentage (%) of land area where minimum January temperatures >15°C (higher risk of coffee leaf rust) and <=15°C (lower risk of coffee leaf 

rust) for the baseline and SSP1-2.6 and SSP5-8.5 considering three future time horizons (2030, 2050 and 2070; P50). Shaded rows represent the six primary 

coffee-producing districts across Sri Lanka. 

 

 

 

 

 

  
SSP1-2.6 

(low emissions future) 
SSP5-8.5 

(high emissions future) 

District 

Baseline 
(1970-2000) 

2030 2050 2070 2030 2050 2070 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Higher 
risk 

Lower 
risk 

Badulla 80 20 90 10 92 8 93 7 90 10 95 5 97 3 

Kandy 90 10 95 5 96 4 96 4 95 5 98 2 100 0 

Kegalle 98 2 99 1 99 1 99 1 99 1 100 0 100 0 

Matale 98 2 99 1 99 1 99 1 99 1 100 0 100 0 

Nuwara 
Eliya 

30 70 40 60 42 58 44 56 40 60 54 46 66 34 
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Appendix F. Suitability analysis – annual rainfall 

Table F1: Suitability of Sri Lanka (% area, by municipality) where annual mean rainfall is 1200-2000mm. Less suitable conditions are where mean annual 

rainfall <1200mm or >2000mm. Shaded rows represent the six primary coffee-producing districts across Sri Lanka. 

 

 

  SSP1-2.6 
(low emissions future) 

SSP5-8.5 
(high emissions future) 

District Baseline 
(1970-2000) 

2030 2050 2070 2030 2050 2070 

Optimal Not 
optimal 

Optimal Not 
optimal 

Optimal Not 
optimal 

Optimal Not 
optimal 

Optimal Not 
optimal 

Optimal Not 
optimal 

Optimal Not 
optimal 

Badulla 99 1 100 0 100 0 100 0 100 0 100 0 99 1 

Kandy 84 16 77 23 76 24 72 28 78 22 75 25 69 31 

Kegalle 17 83 10 90 8 92 6 94 9 91 8 92 3 97 

Matale 100 0 100 0 100 0 100 0 100 0 100 0 100 0 

Nuwara 
Eliya 

74 26 68 32 66 34 63 37 66 34 65 35 60 40 
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